
 

 

 

 

 

Use of ICT in assessing writing for National 3&4 Literacy 

Scribes are not permitted as a reasonable adjustment when learners are required to show evidence of their 
writing skills in SQA National Literacy Units (see http://www.sqa.org.uk/sqa/64698.html) but the use of ICT 
is allowed:  

“In order to minimise the disadvantage faced by some disabled learners in attaining the National 
Units in Literacy, the use of word processors and other assistive technologies such as screen readers, 
spell checkers or speech-recognition software would be acceptable as reasonable adjustments.” 
(Specification 3 - Literacy Units http://www.sqa.org.uk/sqa/64702.html) 

Teachers, parents and learners have asked how ICT can be used to support assessment of writing skills in 
National 3 and 4 Literacy and in this guide we will look at some methods. You might also read our 
companion guide on using ICT for assessing reading available from the CALL Digital Assessment web site. 

The task - meeting the standard for National 3 Literacy Writing 

The National 3 Literacy Unit Specification states that: 

“The purpose of this Unit is to develop the learners’ reading, listening, writing and talking skills in a 
variety of forms relevant for learning, life and work. Learners will develop the ability to understand 
simple ideas and information presented orally and in writing. Learners will also develop the ability to 
communicate ideas and information orally and in writing with technical accuracy.”1 

If we look specifically at the writing assessment standards, the required outcome from the Unit is that: 

“The learner will: 
3 Write simple technically accurate texts by: 

3.1 Selecting and using appropriate language 
3.2 Organising writing appropriately 
3.3 Using appropriate spelling, punctuation and grammar” 1. 

 
Learners are expected to “write simple formal continuous prose which: 

• “contain a few ideas or a set of ideas;  
• contain familiar vocabulary; 
• uses simple expression; 
• is more than 80 words in length.” 2 p.20 

 
Note that assessment of literacy at National 3 or 4 is not ‘an exam’ – it is expected to be carried out in class 
as part of the learning and teaching programme.  
 

1 National 3 Unit Specification: Literacy (National 3): H23W 73 http://www.sqa.org.uk/sqa/47502.html  
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An example of how a teacher might obtain evidence of writing ability is given in SQA’s Literacy 3 Unit 
Support Notes 2 p.13:  

Assessment 
evidence  

Outcome 1  1.1 Selecting and 
using relevant 
information  

1.2 Identifying 
audience and 
purpose  

1.3 commenting 
on effectiveness  

Learner writes a 
section for a class 
web page 

write simple 
technically 
accurate texts 

Web page is 
written in simple 
language which 
makes sense to the 
reader 

Web page uses an 
appropriate 
format/layout, is 
written in sentences 
and uses 
paragraphs/sections 

Learner uses 
appropriate 
spelling, grammar 
and punctuation 

 

In most cases, the writing assessment will follow on from previous work in class where learners will have 
read information about the topic and then undertaken assessment of their reading, talking and listening 
skills.  

On their secure web site, SQA provide three example assessment packages for National 3 and three for 
National 4. These examplars give sample texts and questions and also guidance on assessment. Although 
many subject teachers will use assessment materials that they have created themselves, staff should 
review these exemplars to gain an understanding of the evidence that is required for the assessment.  

In this guidance document, to provide a realistic context for how ICT can be used for the writing task, we 
are thinking of a scenario where the learners have been reading and learning about healthy eating.      

In this example, then, a learner might be writing some text for a web page or a class leaflet about what they 
have learned about healthy eating.  

Writing methods 

For the assessment of writing skills, learners can write their 80 (National 3) or 300 (National 4) words using 
for example: 

• handwriting; 
• handwriting with transcription (i.e. where a member of staff re-writes the pupil’s handwritten 

work); 
• an electronic device such as laptop, iPad, tablet, mobile phone etc (with spellchecker); 
• speech recognition software or other assistive technology. 

The writing assessment is not done under ‘exam conditions’ – it is expected to be part of teaching and 
learning in class and it is not time-limited. When writing, learners can use a number of supports including: 

• extra time; 
• dictionaries; 
• a practical assistant; 
• a prompter; 
• a reader. 3 

 

2 Unit Support Notes — Literacy (National 3), http://www.sqa.org.uk/sqa/47502.html  
3 Guide to supportive practices for National Literacy Units, http://www.sqa.org.uk/sqa/67310.html  
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Writing with ICT 

SQA specify that ICT can be used by all learners for assessment of writing – it is not only those learners who 
have a difficulty or disability: 

“Where resources permit, Centres should use technology as much as possible to support learning, teaching 
and assessment. For the Literacy Unit (National 3), this could include: 

• compiling and maintaining e-portfolios 
• web-based research  
• interactive language tasks such as cloze passages in electronic format  
• word processing/proof-reading  
• listening and responding to and/or creating webcasts  
• games-based learning  
• using chat rooms for discussion  
• using virtual learning environments  
• video conferencing  
• discussing, reading and writing formal blogs  
• reading and responding to e-mails  
• submission of assessed work through VLE/e-mail online quizzes/tests  
• mind mapping software  
• internet voice calls  
• web conferencing.” (2, p. 10) 

Can learners use a spellchecker? 
Yes: all learners can use a spellchecker: “Learners should be supported to spell words accurately, using a 
range of strategies and resources to do so. Commonly available support, such as an electronic spell checker 
and other technical support, is acceptable for on-screen writing.” (2, p. 9) 

Can learners submit more than one draft of their writing? 
No: “In writing, learners will produce technically accurate word-based texts which communicate meaning at 
first reading.” (2, p. 9) 

Is sentence structure and grammar assessed? 
Yes: “Learners should develop skills in structuring sentences in different ways, in using appropriate 
punctuation and in writing grammatically.” (2, p. 9) 

Can text-to-speech software be used? 
Yes. Many learners find text-to-speech software very helpful for proof-reading their work. By having the 
text read back, learners can identify mis-spelled words and improve sentence structure and meaning.  

Can mind-mapping [software] be used? 
Yes: “Learners should be encouraged to plan their writing, for example, by creating mind maps, through 
peer discussion or by considering options about content, layout and format. In planning and preparing for 
writing, learners will consider the genre, audience and purpose for their writing.” (2, p. 8) 
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Writing Tools in Microsoft Word 

Microsoft Word is the most commonly used word processor in Scottish secondary schools, and so we will 
look at tools and options within Word that can help learners with spelling or writing difficulties. The 
examples below are all done using Word 2010; other versions of Word have similar accessibility features. 

Keyboard 
Many pupils with visual, physical, learning or reading difficulties can use a keyboard to overcome difficulties 
with handwriting or spelling. For example: 

• Learners who experience pain or fatigue when handwriting may be able to write more, faster and 
with less effort by using a keyboard. 

• Learners can more easily edit and correct errors and so produce higher quality work as a result.  

• Learners with very poor handwriting can produce more legible work with a computer (benefitting 
both markers and the pupil, who is able to read their own work more easily). 

• Learners with dyslexia or reading difficulties can use built-in support tools such as spellchecker and 
AutoCorrect. 

 

 

 

Spellchecker 

Microsoft Word’s spellchecker underlines words which may be mis-spelled.  This draws attention to words 
which are likely to be mis-spelt, but perhaps more importantly it helps confirm correctly spelled words: 
many dyslexic candidates waste time going over words which are actually correctly spelt.   

To spellcheck: 

• Right-click on a word; if you see the correct spelling, click on it to replace it, or 
• Click Review > Spelling and Grammar, or 
• Press F7. 

Solubility and Saturated Solution 

When a solute is added to a solvent a 
solution is formed. How much solute we can 
dissolve depends on temperature of the 
solvent, the solvent yosed and the volume 
of the solvent. When a solution contains as 
much solute as it possibly can at that 
temperature, we say the solution is 
saturated. No amount of stirring or shaking 
will allow more solute to dissolve. Only by 
heating the solution or adding more solvent 
is it likely that more solute will dissolve. 

Figure 1: A comparison of handwritten and typed text from a student with dyslexia 
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Figure 2: Microsoft Word’s Spellchecker 

Talking Spellchecker 
To use a spellchecker, the writer must be able to identify the correct word in the list of words. Some 
learners with reading or word recognition difficulties have difficulty choosing the correct word from the list 
and so they benefit from having the word read out by the computer. A good option here is Rod Macaulay’s 
WordTalk program which is free from www.WordTalk.org.uk.   

 

With WordTalk, the learner can 
click on the words in the spelling 
list to hear it read out, and also 
find and listen to synonyms.  

Talking spellcheckers are provided 
by many literacy support 
programs such as for example 
ClaroRead, Co:Writer, Ghotit, Read 
and Write Gold or Verity Spell.   

 

 

 

 

 Figure 3: WordTalk Talking Spellchecker 
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Auto-correct 
The Microsoft Word AutoCorrect tool corrects spelling or typing mistakes automatically. This can be 
extremely helpful for learners who make common spelling or typing mistakes: for example, it will replace 
‘teh’ with ‘the’; ‘geting’ with ‘getting’; ‘tecnical’ with ‘technical’, and so on. Most writers use AutoCorrect 
without thinking or realising they are doing so. 

To turn on AutoCorrect: 

• Click File > Options > Proofing > AutoCorrect Options and tick Replace Text as you Type. 

However, AutoCorrect can also be adapted or ‘taught’ to 
correct a writer’s own personal spelling errors. For 
example, suppose a dyslexic learner cannot spell 
‘enough’, and always types it as ‘enuf’ or ‘anuf’. Both 
these mis-spellings can be added to the Word 
AutoCorrect dictionary so that both are automatically 
corrected. 

To add words to the AutoCorrect dictionary: 

• Click File > Options > Proofing > AutoCorrect 
Options. Type in the misspelling (enuf) under 
‘Replace’, and the correct spelling (enough) under 
‘With’. Repeat for any other common mis-
spellings of the same word. 

Adding words one at a time in this way may seem like 
hard work, but it can over time develop into an extremely 
effective tool for helping learners with dyslexia write more 
accurately.  

 

An example 
On the next page there is an example of writing (126 words - National 3 requires 80 words) about healthy 
eating typed with and without the use of AutoCorrect and the Word spellchecker. By using the 
spellcheckers the number of errors in this example is reduced from 50 to 9. However, there are also 8 ‘real 
word errors’ or homonyms such as ‘cud’ instead of ‘could’; ‘sum’ instead of ‘some’; ‘bred’ instead of 
‘bread’; and ‘sup’ instead of ‘soup’. 

Note that this is given as an example to illustrate the type of spelling mistakes that can be addressed using 
the readily available Microsoft Word tools. Some learners with spelling difficulties find they can use these 
tools to greatly improve their spelling accuracy, but others, possibly with more severe literacy difficulties, 
find that spellchecking tools are not particularly helpful. For example, some learners with very severe 
literacy difficulties may require other supportive software such as word prediction or speech recognition 
(see below).  

Schools therefore need to conduct an assessment of ability and need to determine the most suitable tool 
for the individual learner. 

 

 

Figure 4: Adding words to the AutoCorrect 
Dictionary 
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How effective are spellcheckers in practice? 
The example illustrates that a spellchecker is unlikely to help a learner correct all spelling mistakes errors - 
because spellcheckers: 

• may ignore homonyms (for example sum for some, her for hear, or who for how); 
• do not always offer the correct spelling for an error; 

and because the candidate may not identify the correct word in the list offered by the checker, only a 
proportion of spelling errors will be corrected. 

Research suggests that 26% to 40% of spelling errors made by writers with spelling difficulties are not 
identified as an error by the spellchecker (MacArthur, 19964), because they are homonyms. Some 
spellcheckers designed for writers with spellcheckers do check homonyms as well as mis-spelled words (see 
Specialist Spellcheckers later). 

4 MacArthur, A., Graham, S. Hayes, J. A. & De La Paz, S. (1996) Spelling checkers and students with learning disabilities, 
Performance comparisons and impact on spelling. The Journal of Special Education 30, 1, 35-57. 
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According to a study by James and Draffan5, the Microsoft Word spellchecker can identify and correct most 
(over 94%) of simple errors but is less effective when dealing with more severe errors of the type made by 
many writers with dyslexia. Specialist programs such as ClaroRead, Ghotit, Co:Writer, Ginger, Read and 
Write Gold and Verity Spell may be more effective in these situations. 

MacArthur reported that just 36% of writers’ errors were successfully corrected by using a spellchecker. 
However, 36% is better than 0%, and the Word spellchecker may well be all that is required for a learner to 
successfully achieve the standard for writing at National 3 or 4.  

Make the text larger or smaller 
Many learners with visual impairment or a reading difficulty, including dyslexia, benefit from a bigger font 
size both for reading text and when writing.  

• Click View  >  Zoom to zoom in to make the text larger, or use the slider in the bottom right corner, 
or hold down CTRL and scroll the mouse. 

• Click View > Web Layout and then zoom in to choose a large font size. Web layout will reflow the 
text so that you don’t have the scroll left and right if you have high levels of magnification. 

Change the page background and text colour 
Learners who have visual stress or dyslexia may find text on a coloured background easier to access. Some 
learners with visual impairment may need a high contrast colour scheme (e.g. yellow on black) as well as 
magnification. 

• Click Page Layout > Page Colour and choose a different page background.  

• Select all the text (CTRL-A), click the Home ribbon and choose a different text colour. 

 

Figure 5: “Web layout” with zoom at 500%, pale orange background and black text 

Change the font, font size and line spacing 
Some learners find it easier to read text in particular fonts, or to see a larger font size: 

• Select all the text (CTRL-A), click Home and choose a different font and/or font size. 

5 The Accuracy of Electronic Spell Checkers for Dyslexic Learners, http://www.dyslexic.com/spell-checker-accuracy  
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Many learners with a visual impairment, visual stress, visual tracking problems or dyslexia can read and 
write more comfortably and fluently when each line of text is spaced further apart:   

• Select all the text (CTRL-A), click Home and then the Line and Paragraph Spacing button, and 
choose the line spacing you want (try 1.5 or 2.0 for line-and-a-half, or double spacing).  

 

Figure 6: MS Word page with Verdana 18, coloured background, and double line spacing 

 

Reading text with text-to-speech software 
Many learners with literacy difficulties find that it is very helpful to use text-to-speech software both when 
writing and for reading back their text. While writing, some TTS programs can speak each word or sentence 
as it is typed, which can help the writer identify mis-spellings. Reading back the text with TTS may help the 
writer to improve punctuation, sentence structure, vocabulary or meaning.  

There are many text-to-speech programs you can use to read text from a Word document, and we’ll look at 
just two of them here by way of example. These tools are both free. 

Text-to-speech programs need voices installed on your computer. Your PC will probably have one or two 
voices already installed, but the standard voices have American accents, so we recommend using the free 
Scottish computer voices from the web site at http://www.thescottishvoice.org.uk/. These are high quality 
male (‘Stuart’) and female (‘Heather’) voices which work with almost all text-to-speech programs on 
Windows and MacOS computers. 

These voices are licenced for school and home use for learners in Scotland. Many local authorities have 
installed them on all their school computers as a reasonable adjustment under Equality and Accessibility 
legislation, and also as a tool for all learners. If you don’t have them on your computers, ask your technical 
service to download and install them. 

Word Speak button 
Word 2010 and 2013 have a free text-to-speech tool called ‘Speak’. To add it to the toolbar, follow the 
instructions in the blog post here: http://www.callscotland.org.uk/Blog/Blog-Post/?reference=333. 
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Once you have the Speak button in the toolbar, select the text you want to read and click Speak, and the 
text will be read out using the computer’s default voice. The Word Speak button cannot read the text as 
you type. 

 

Figure 7: Reading text with Word's Speak button 

 

If you want to change the default voice or the voice speed, open the Speech Recognition Control Panel, 
click Text-to-Speech, and choose the voice and settings you want to use. (If you cannot access the Control 
Panels, contact your technical service or school ICT coordinator.)  

 

Figure 8: Changing the default computer voice for Word Speak button 

 

WordTalk 
WordTalk is a free add-on for Microsoft Word that gives more options and tools than the Word Speak 
button. For example, WordTalk highlights as it reads so the learner can track the text; it lets you change 
voices and voice speeds without having to access the Control Panels; it can echo back each word or 
sentence as you type; and learners who have difficulty with a mouse can use keyboard shortcuts. It also has 
a talking spellchecker and you can save text as audio files (for playing back on an iPod, for example). 

WordTalk works with most combinations of Word and Windows. You can download it free from the web 
site: http://www.wordtalk.org.uk/. 
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Once you have WordTalk installed, click on the Add-Ins ribbon, place your cursor where you want to read, 
and click the relevant WordTalk button to read the paragraph, sentence, word, or the whole text.  

 

Figure 9: Reading text back with WordTalk 

 

If you want to hear each word or sentence spoken back as you type, click the 
‘Spanner’ button then Options and tick the Echo Words and/or Echo 
Sentences button.  

 

 

 

 

There are many free and paid-for text to speech programs you can use – too many to cover them all here – 
but we have listed some of the more popular tools below. 

Text Readers 
Text readers are mainly designed for designed for people who can see to click on or select text, and have it 
read out by the computer. 

iVona 
MiniReader 

Simple toolbar for reading from anything – Word, PDF, Internet etc. Free 

Natural 
Reader 

Simple toolbar for reading from anything – Word, PDF, Internet etc. Free 

MyStudyBar A set of accessibility tools including a text reader. Free 
ClaroRead Comprehensive literacy support software. Text-to-speech; word prediction; 

talking spellchecker; easy font, spacing and colour adjustment; scanning etc.  
http://www.clarosoftware.com/  

From £49 

Read and 
Write Gold 

Comprehensive literacy support software. Text-to-speech; word prediction; 
talking spellchecker; easy font, spacing and colour adjustment; scanning etc. 

From £320 

Co:Writer 7 Word predictor with text-to-speech. 
http://www.educationscotland.gov.uk/about/ordereducationresources/  

£39 per 
licence 

Penfriend Word predictor with text-to-speech. 
http://www.educationscotland.gov.uk/about/ordereducationresources/  

From £45 
per licence 

Figure 10: WordTalk 'Echo' 
tools 
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Screen Readers 
Screen readers are designed for blind people. They operate quite differently from text readers and read out 
everything on the screen. They can all read Word documents. 

NVDA Free screen reader that can read Word and PDF files, the internet, and allow 
a blind user to access the computer. 

Free 

Jaws Screen reader that can read Word and PDF files, the internet, and allow a 
blind user to access the computer. 

From £659 

Supernova Screen reader that can read Word and PDF files, the internet, and allow a 
blind user to access the computer. 

From £295 

   

Other tools to support writing 

The previous section summarised tools that are available or can be made easily available within Microsoft 
Word. In this section we will discuss other programs and tools that can support writing. Most of these can 
be used to type into Word.  

Specialist Spellcheckers 
There are several ‘specialist’ spellcheckers that are designed specifically for learners with spelling or literacy 
difficulties, such as ClaroRead, Ghotit, Read and Write Gold and Verity Spell. These may give better results 
than the Word spellchecker depending on the type of spelling mistakes that the learner typically makes.  

A comparison of these programs is available on the CALL web site and the BDA Technology web site also 
has summaries. 

Word prediction 
Word predictors analyse text as it is typed on the computer, and try to ‘predict’ the words that the learner 
is most likely to want from a dictionary or lexicon of words. The writer types or selects a letter and the 
program offers a list of the most common words beginning with that letter. If the required word is on the 
list, the writer selects it with mouse, keyboard or other access tool. If the word is not on the list, the learner 
types the next letter and a different choice of words is offered. 

 

Figure 11: Writing with word prediction 

There are many word prediction programs available, including Co:Writer, ClaroRead, LetMeType, Penfriend, 
Read and Write Gold and Write:Online. Some Scottish local authorities have authority-wide licences for 
some of these programs. There are prices and sources on the next page.  

Word prediction can reduce the number of keystrokes needed to type by up to 50% and so learners with 
physical disabilities use them to reduce effort and increase endurance and therefore the amount that can 
be written in one session.  
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Word prediction can also help learners with even quite severe spelling difficulties because the writer only 
needs to type the first few letters of the word and then select it from the list of words offered. The learner 
can usually point at the word to have it read out, to make sure it is the correct word.    

Some literacy skills are necessary to be successful with word prediction. The writer must be able to decide 
what they want to say, type a reasonable approximation to the first few letters of the word and then 
recognise the word in the list. Some writers cannot get the first letters right; others may miss the word 
when it is offered in the list or choose a different one by mistake. Some pupils also find that shifting 
attention between the text, the keyboard and the predicted list interrupts their flow of thought and slows 
them down. 

Word prediction in assessment of literacy 

At time of writing we believe that SQA will regard word prediction as a reasonable adjustment but this is 
not confirmed. Note that the predictor should only offer single words, not phrases or sentences. 

Word prediction & specialist spellcheckers 
MyStudyBar A set of accessibility tools including the LetMeType 

predictor. 
Free 

ClaroRead Text-to-speech; word prediction; talking spellchecker; easy 
font, spacing and colour adjustment; scanning etc.  
http://www.clarosoftware.com/  

From £49 for single 
user licence 

Co:Writer 7 Word predictor with text-to-speech. 
http://www.educationscotland.gov.uk/about/ordereducati
onresources/  

£39 for single user 
licence 

Ghotit Context and phonetic spellchecker, grammar checker, word 
prediction, text-to-speech. Requires internet connection.  

Free basic version; 
single user £128. 

Penfriend Word predictor with text-to-speech. 
http://www.educationscotland.gov.uk/about/ordereducati
onresources/  

£45/£90 for first 
licence; £15/£22 
for additional 
licences.  

Read and Write Gold Text-to-speech; word prediction; talking spellchecker; easy 
font, spacing and colour adjustment; scanning etc. 

£320 for single 
user licence 

Verity Spell Phonetic spellchecker, homonym checker and dictionary. £70 for single user 
licence. 

Write:Online Word processor with text-to-speech, word banks and 
prediction. 

£150 for single 
user licence. 

Speech Recognition 

Speech recognition software, where the learner speaks and the computer or device recognises the speech 
and converts it into text, is regarded as a reasonable adjustment for assessment of writing for National 3 or 
4 Literacy. 

Speech recognition is provided free with Windows 7 and 8, recent versions of MacOS, and is also built in to 
the iPad (Mini and iPads 3 or 4 with retina display).  

The Dragon speech recognition software is also available for Windows, Mac and iOS and the latest Dragon 
NaturallySpeaking for Windows claims to be ‘up to 99% accurate out of the box’.  
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Finally, WordQ + SpeakQ is designed specifically for writers with literacy difficulties and integrates speech 
recognition, word prediction and text-to-speech. 

Certainly, speech recognition software is far more accurate, and requires far less training, than was 
previously the case, but it is still not commonly used in schools.  

Learning to use speech recognition does require time, effort and support and good ICT and language skills. 
The writer must be able to compose satisfactory English and to dictate clearly and accurately. Learners with 
strong dialects or regional accents, or unclear speech may not be able to use the software. Speech 
recognition is unlikely to be 100% accurate, and so the writer must be able to read back the dictated text 
and identify and correct mis-recognised words. 

You can find out more about speech recognition from: 

• Speech Recognition Software from http://bdatech.org/what-technology/speech-recognition/  
• Solutions for Learning Challenges from http://www.nuance.com/dragon/accessibility/dragon-

dyslexia-learning-challenges/index.htm  
• Speech Recognition in National Assessments - Update August 2013 and 
• Speech Recognition Software in SQA Assessments from 

http://www.adapteddigitalexams.org.uk/Downloads/Reports-and-Presentations/  

 

What about learner’s who cannot use standard keyboard or mouse? 

Learners with physical disabilities who cannot use a standard keyboard or mouse may be able to write by 
using an alternative method of access, such as speech recognition; mini or large keyboard; or an on-screen 
keyboard controlled with a mouse, trackball, joystick, head-operated mouse, eye-gaze or switches).  

Finding the most efficient and effective method of access usually requires specialist assessment and trial of 
different options from an organisation such as CALL Scotland. 

The use of Communication and Assistive Technologies for disabled candidates in Assessment, written by 
CALL staff, provides an overview of access and other technologies for learners with disabilities. 

 
 
 
 
 
 
 
 
Paul Nisbet 
CALL Scotland, University of Edinburgh 
http://www.callscotland.org.uk 
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http://www.adapteddigitalexams.org.uk/Common-Assets/ckfinder/userfiles/files/Speech%20Recognition%20in%20National%20Assessments%20July%202013.pdf
http://www.adapteddigitalexams.org.uk/Common-Assets/spaw2/uploads/files/Speech%20Recognition%20in%20SQA%20Assessments%20Final.pdf
http://www.adapteddigitalexams.org.uk/Downloads/Reports-and-Presentations/
http://www.adapteddigitalexams.org.uk/Common-Assets/spaw2/uploads/files/Communication%20and%20Assistive%20Technologies%20in%20Assessments.pdf
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